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T he first part of this chapter is intended for complete beginners to Painter and

contains simple exercises to guide the user in identifying the key areas of the

workspace prior to first using Painter. If you have previously used Painter you may

wish to skim this section or just pick up on the newer features.

The second part of the chapter contains information to enable you to customize the

program to your own requirements and covers the use of Graphic Tablets and setting

Preferences to make the work process smoother and quicker.

Both sections can be used as a quick reference guide to the key elements as you work

through the step-by-step examples in later chapters.

Information on printing and color management can be found in Chapter 14.

Many readers will have already used and be very familiar with Adobe Photoshop 

and for them I have included a section highlighting the differences between the two

programs, sometimes the naming of techniques differs and of course where to find

particular commands. There are also tables of file compatibility, tools and keyboard

shortcuts.

PA
IN

TE
R 

X 
FO

R 
PH

OT
O

G
RA

PH
ER

S

2

The Painter X workspace.Figure 1.2
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The Painter X workspace

The default view
Figure 1.3 shows the default view of Painter X with the File bar at the top of the screen, the

Properties bar just beneath, leading to the Brush Selector on the right. The Tools are on the

left and a selection of palettes on the right.
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The default view of Painter X.Figure 1.3

Toolbox
The Toolbox is where all the tools are

stored (no surprise there then) and

Figure 1.4 shows the Painter X

Toolbox with all the hidden tools

revealed and shown in red.

To access the hidden tools click and

hold the visible tool and the other

options will appear to the side, just

click the one required. 

Some of the important tools which are

being used in this book are detailed in

this chapter, but most are very obvious

by their icons.

Keyboard shortcuts are set up for

many of the regularly used tools and others can be customized in the Preferences menu.

A full explanation of all the tools can be found in the Painter program under Help� Help Topics.

The Toolbox with hidden tools shown in red.Figure 1.4
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Opening a picture in Painter
Painter is able to use several different types of pictures. If you are bringing in pictures from a

digital camera, the most common file types are JPEG or TIFF format. If you are importing a

picture that has been saved in Adobe Photoshop the file type is likely to be PSD. Painter will

happily use all these file types and several others. Painter does have its own file type called

RIFF, however when using photographs it is not necessary to use this in the majority of cases.

It is generally desirable not to use very large image files as they will slow the program down

and some of the complex brushes in particular can be very slow.

If the image is to be printed then a resolution between 150 and 300 dpi is preferable which

means a file size of between 10 and 20 Mb. For web use a much smaller file size can be

used, in most cases around 1 Mb. More information on file sizes and printing can be found

in Chapter 14.

Figure 1.3 shows the first picture on the DVD which is opened from the file bar by going to

File� Open� DVD� Step-by-step files� ‘01 Stained glass window’. You can use this or if

you prefer use your own photograph.

Brush Selector
The Brush Selector is where the type of brush is chosen, brushes are at the heart of

everything in Painter and are dealt within a lot more depth in Chapters 3 and 4.

On the right of the Properties bar is the Brush Selector. Click the brush icon on the left and

the drop down menu will reveal the extensive range of brush categories that are available.

Click and drag down the right bottom

corner of the menu to see the full list of

brush categories. Select the Oils category.

Click on the right hand icon to reveal

another drop down menu that shows the list of variants for the Oils brush category. Once

again you will need to drag down the list to reveal all the variants. This is a very large

category and will give some idea of the huge number of brushes available. Click on the

Bristle Oils 30 brush as illustrated in Figure 1.5.

Picking a color from the Colors palette
To choose a color to paint with go to the Colors palette, which should be visible on the right of

the screen. If this is not the case go to Window� Color Palettes� Show Colors and it will appear. 

Figure 1.6 shows the Colors palette. Click in the outer colored circle to choose the hue or

color. The inner section defines the brightness of the color, the pure color is on the right,

the darker colors bottom left and lighter at the top, click within the triangle to choose the

tone. The blue square (bottom left in Figure 1.6) is the Main color and confirms which color

has been chosen. The Colors palette is explained in more detail in Chapter 10.
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The Brush Selector.Figure 1.5
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Draw some lines on the picture to get a feel for the brush. 

If you are using a graphic tablet you will see that the brush

responds differently depending on the angle used, this is

common to many of the brushes. I recommend that you use

a graphic tablet as it is essential for getting the most out of

the program. At the end of this chapter there are some tips

on setting up your graphics tablet for Painter.

Now try a brush from the Chalk brush category, click on

Square Chalk 30 which is very different to the Oil brush.

Try some of the other brush categories yourself but for the

moment avoid the Watercolor and Liquid Ink categories as they need a special layer to work

on and will be explained in more detail in Chapter 8.

Properties bar
Figure 1.7 shows the Properties Bar, this is a context sensitive bar and changes to whatever tool

is currently active. In the example shown it is relevant to the Brush and this is where the brush

size is usually changed. Alongside this is the Opacity setting that adjusts the density of color

being put onto the paper. The other settings will be dealt with in more detail in Chapter 4.
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The Properties bar.Figure 1.7

Correcting mistakes
Your image will now be covered with paint

strokes so this is a good point to show how

to correct mistakes and if necessary return

a picture back to its original state.

The very valuable Undo command is found

in the Edit menu and as we have been

using a brush the line will read Undo Brush

Stroke. Click on this and the last brush

stroke will be undone, click on it again and

the previous brush stroke will also be

undone. As you can see, the command works backwards and continues to remove the last

action taken until you reach the maximum numbers of Undo, which is 32 steps. This

number can be changed in the Preferences menu which is covered later on in this chapter. 

Rather than go to the menu every time you want to use the Undo, it is much quicker to use

the keyboard shortcut which is Ctrl/Cmd � Z. If you are a Photoshop user you will need to

be aware that the Undo command in Painter works differently and is not a toggle action.

To ReDo an action, go to Edit� ReDo or use the shortcut Ctrl/Cmd � Y.

The Colors paletteFigure 1.6

Correcting mistakes.Figure 1.8

CH001.qxd  4/20/07  3:06 PM  Page 5



If you want to get back to the original, go to File� Revert. Confirm you want to do this by

clicking Revert in the pop up dialog box and the picture will return to its original state. This

will work provided the original picture is still in the same place from which it was loaded,

either on your computer or on the DVD.

Moving around the picture
One of the great advantages with

all graphic programs is the ability

to enlarge the picture to work at a

more detailed level. The quickest

way of doing this is to use the keyboard shortcuts, but I will give the Toolbox method as well.

Click on the Magnifier in the Toolbox and click in the picture, this will enlarge the picture

by 25% each time you click. To reduce the magnification, hold down the Opt/Alt key and

click in the picture again. When the Magnifier tool is active there are three buttons on the

Properties bar that give pre-set views.

Actual Pixels show the image at 100% enlargement, which is very useful for checking detail.

Fit on Screen will show the whole picture on the screen as large as possible without being

hidden by anything else.

Centre Image will return the image to the centre when it has been magnified.

Another way to change the magnification is to use the slider at the base of the document

window (Figure 1.10). The percentage number shown on the right of the bar is the current

magnification of the picture. Type in an amount and press enter to go to a specific

magnification. Increase the magnification significantly then click on the binoculars icon

shown in Figure 1.10 to the left of the slider, this will show you which part of the image is

being magnified.

The screen is shown in Figure 1.11 with

the full picture in the small rectangle

bottom left and a red rectangle showing the

part of the picture that is being shown on

screen. Click and drag inside the rectangle

to move the point of magnification.

Click the Grabber (hand icon) in the

Toolbox and the cursor will change to a

hand, click and drag in the window to

move the image. Double click on the

Grabber icon in the Toolbox and the

picture will change from a magnified view

to the full picture being visible on screen.
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Using the Navigator.Figure 1.11

Magnifier options on the Properties bar.Figure 1.9

Using the slider to magnify the picture.Figure 1.10
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Rotating the canvas
The Grabber is one of several tools that

have alternative options in the Toolbox.

Click and hold the Grabber and select the

second icon with a circular arrow. This 

is the Rotate Page tool and allows the

picture to be rotated to make it easier to

paint with certain brushes. Don’t get this

confused with the Rotate Canvas

command in the Canvas menu, this tool

simply turns the picture around in the

same way a traditional artist might move

a canvas around to get a better angle.

Click and drag in the document window to see the image rotate, to return to the original

position click once on the canvas or double click on the Rotate Page icon in the Toolbox.

Figure 1.12 shows the rotated

canvas.

Normal view
The Normal view is shown in 

Figure 1.13 and the picture is

contained within its document

window. The Full Screen option

frees the image from the confines of

the document box and fills the

entire screen including behind the

palettes and Toolbox. This is a good

way to work as it allows more

freedom to move the image around

on screen and removes much of the

clutter.

Full screen view
Figure 1.14 shows the Full Screen

View, to use this mode either go to

the Window menu and click on

Screen Mode Toggle or use the

keyboard shortcut Ctrl/Cmd � M.

This is a toggle action so pressing

the keys again will revert to the

normal view.
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Rotating the canvas.Figure 1.12

Normal view.Figure 1.13

Full screen view.Figure 1.14
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Keyboard shortcuts for the screen
Ctrl/Cmd �� will magnify the image.

Ctrl/Cmd �� will reduce the magnification.

Ctrl/Cmd � Alt/Opt � 0 will show the picture at 100% (Actual pixels).

Ctrl/Cmd � 0 will make the image fit on the screen.

Pressing the Spacebar while painting will activate the Grabber to enable the image to be moved.

Using and organizing palettes
There are over 30 palettes in Painter X and even though they will collapse and stack very

neatly they do take up room on the screen that could be used for the image. Many of them are

not usually needed when using photographs so fortunately they are easy to organize and

unwanted ones can be removed.

To remove a palette from the screen, click on the cross in a square on the palette header. To

show palettes not visible on the screen, go to the Window menu and click on the name of

the palette you want, some of the palettes are arranged in groups for convenience.

To expand or close a palette, click either on the

triangle on the left or on the name of the palette

itself. To move and link palettes together click on the

blank area to the right of the palette name and drag

the palette over another palette and they will dock

together.

Figure 1.15 shows the palettes that I keep on the

screen and use regularly, they are usually kept

collapsed as shown and opened when required.

Creating custom palettes
It is often very useful to create custom palettes, some

to use on a regular basis and others just for a

particular picture or project. Here is a quick guide to

creating a custom palette with a variety of shortcuts.

Select a brush variant from the brush selector, click on

the variant icon and drag it out into the main

workspace. A custom menu will be immediately

created as in Figure 1.16; you can now add further items to the palette. Select a brush from

another brush category, drag that onto your new custom palette, and position it to the right of

the original icon.

The icon can be positioned anywhere on the custom palette, alongside or below. If you want

to re-arrange the icons hold down the shift key and drag the icon to where you want it to be.

To delete an icon hold down the Shift key and drag the icon off the palette.
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Useful palettes to keep on
screen.
Figure 1.15

Custom palette.Figure 1.16
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Now add a paper texture, open the Papers palette or use the quick icons in the Toolbox and

drag the paper icon from the palette onto the

Custom palette.

Menu commands can also be added, go to

Window� Custom Palette� Add Command and

the dialog box shown in Figure 1.17 appears,

select the name of the palette you are working

on. To add the Tracing Paper command, go to

Canvas� Tracing Paper then return to the Add

Command palette and click OK, the shortcut

will appear on the new palette.

To delete or rename custom

palettes go to Window� Custom

Palettes� Organizer, highlight the

palette you want to change and

click the relevant button. Painter

will remember this palette each

time you open the program but to

save a really useful palette

permanently it can be saved as a

file by pressing Export. The Import

button will add palettes previously

saved. Figure 1.18 shows an

example of a Custom palette fully created.

Palette menu
One further note regarding palettes: on the

right side of the palette name is a small

triangle (circled in Figure 1.19) that indicates

the palette contains a Palette menu. This is a

further selection of options relevant to that

particular palette, click and hold on the

triangle to see the drop down menu. The

various palettes will be looked at in more detail

as you work through the step-by-step examples

in the book.

Brush Creator
The Brush Creator is covered in some detail in Chapter 4, but gets a quick mention here as

it is used in a few step-by-step examples in earlier chapters.

9

G
ETTIN

G
 STARTED IN

 PAIN
TER

Add command to custom
palette.
Figure 1.17

A custom palette for cloning.Figure 1.18

The palette menu extended.Figure 1.19
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This palette, which is accessed by the Ctrl/Cmd � B shortcut or from Window�Show

Brush Creator, houses the controls for customizing brushes. Clicking on a category from

the list on the left opens the relevant sub palette and reveals the sliders and options

available. On the right is the Scratch Pad where brushes can be tried out prior to use.

In Painter X all the sub palettes are also available as separate palettes that can be brought

on the screen individually which is very useful as many of the palettes are rarely used. One

palette I recommend you keep on screen is the General palette and this is available from

Window� Brush Controls� General.

In some earlier versions of Painter

this is not available separately but it

can be accessed from the Brush

Creator.

Using a graphic tablet
A graphic tablet with a pressure

sensitive stylus is a must to obtain the

Painter brushe’s full potential.

Wacom are the leading brand of

tablets and have a large range from

small to very large sizes. I personally

find the A5 (6 � 8 inch) size ideal, it

is large enough to have ample room

for brush strokes yet not take up too

much space on the desktop.
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The Brush Creator.Figure 1.20

Brush tracking in the Preferences menu.Figure 1.21
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How you set up the button configuration for your pressure sensitive pen is a matter of

personal preference, once the software has been installed on your computer the controls

can be accessed via the Control Panel for Windows or in Applications on Mac OS X.

All the brush and opacity settings used throughout the book are for use with a graphic

tablet. If you are using a mouse you will need to reduce the specified opacities quite

considerably.

Brush Tracking is a control within Painter to adjust the sensitivity of the pen to suit 

your own hand. In the Edit menu go to Preferences and select Brush Tracking in the 

dialog box.

Make a few sample strokes pressing at various intensities in the Scratch Pad as in Figure

1.21 and Painter will automatically adjust the pen sensitivity to your own hand pressure.

Saving images
There are three options for saving images available from the File menu.

Save, will save the image, overwriting the original file.

Save As, will save a copy under a different name if required.

Iterative Save, is very useful when you need to keep interim versions of the image showing

different stages of completion. Each time the image is saved Painter adds an incremental

number to the file, 001 then 002 and so on. This is a very useful option for returning to an

earlier stage, usually these interim saves are deleted when the image is completed.

Painter will save images in several file formats, but generally it should be saved in the same

file type in which it was originally opened. In the case of photographs this will usually be

PSD if it has come via Photoshop or JPEG if from a digital camera. 

Images that started as JPEGs should be saved as a PSD, or RIFF (see below) while being

worked on in Painter, as continually saving in JPEG format will degrade the image 

quality. 

The native file format for Painter is RIFF which would be chosen were the program being

used for original painting rather than working from photographs. 

It is however advantageous to use RIFF when particular brush categories are used, these

are mainly Watercolor and Liquid Ink, in RIFF file format these can be saved and re-opened

at a later date and brush strokes can be edited. Mosaics are another case where it is useful

for RIFF to be used for the same reason. If you are a Photoshop user it is easy to think of

these as adjustment layers which are permanently editable until the file is flattened.

Dynamic Plug-in layers which are available from the bottom of the Layers palette are also

very similar to Photoshop adjustment layers and are not editable once the file is saved in

any format other then RIFF.
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